WINDOWS SERVER 2012 ON DELL - GREAT PERFORMANCE AND VALUE
FOR THE NEXT GENERATION PLATFORM: A SHAREPOINT STUDY

Great performance, lower cost.

1 Dell™ EqualLogic™ PS6110XV storage array with
2 Dell PowerEdge™ M620 blade servers provided

o lower cost
per user

The Dell solution supported 3,000 SharePoint®
users for lower cost than the HP solution.

As companies strive to increase efficiencies and communication mechanisms for
their team efforts, they are demanding comprehensive software to enhance online
collaboration between workers. Microsoft® SharePoint Server 2010 helps this effort by
centralizing and organizing the documents in editing, preventing multiple employees
from accidentally overlapping edits on the same document or circulating outdated
versions. Choosing the right hardware solution to power such collaboration software is
vital; you need to choose servers and storage that can consolidate multiple workloads,
support a large number of users, speed up collaboration between employees, and
provide your IT administrators with the necessary management tools—all without
breaking the bank.

In Principled Technologies’ labs, we compared the virtualized SharePoint Server
2010 performance and hardware cost of a Dell solution with two Dell PowerEdge M620
servers and one Dell EqualLogic PS6110XV storage array to an HP solution with two HP
ProLiant BL460c Gen8 blade servers and a leading competitor storage array. Both
solutions hosted their virtual machines (VMs) on Windows Server® 2012 with Hyper-V™.
We found that the Dell solution supported the 3,000-user SharePoint workload at a 26.0
percent lower cost than the HP solution.
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MEET YOUR COLLABORATION NEEDS WITH DELL

When deploying a Microsoft SharePoint collaboration software solution, it is
important to select hardware that can support the required number of users with great
end-user performance and still meet your budget constraints.

We tested the SharePoint Server 2010 performance of two collaboration
solutions: the Dell PowerEdge M620 solution, which included two Dell PowerEdge M620
servers and a single Dell EqualLogic PS6110XV storage array, and the HP ProLiant BL460c
Gen8 solution, which included two HP ProLiant BL460c Gen8 blade servers with a
leading competitor external storage array. We selected this HP configuration because it
is common for an HP server environment to employ third-party storage. For more
information about the exact configuration of the HP and Dell solutions we tested, see
Appendix A.

For both solutions, we virtualized SharePoint using Microsoft Hyper-V for
Windows Server 2012. We used a 3,000-user Microsoft SharePoint workload that both
solutions could support with less than a 1-second latency, which would provide a good
experience for end users. For more information about our tests, see the What we tested
section. For step-by-step details, see Appendix B.

Both virtualized solutions could support the 3,000-user SharePoint workload,

but the cost to support those users with each solution was considerably different.

Lower cost per user with the Dell PowerEdge M620 solution
When comparing the cost of each solution, we took into account hardware costs

as well as the cost for management tools that a server administrator would typically use.

As Figure 1 illustrates, the Dell solution was more cost-effective than the HP
solution, lowering the cost of each SharePoint Server 2010 user by 26.0 percent. One of
the key benefits of the Dell solution is that it provides many management tools,
including storage snapshot and monitoring software, at no additional cost. Such storage
tools involve extra cost with most storage providers.
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Figure 1: The Dell PowerEdge M620 solution costs $28.40 per SharePoint user, 26.0 percent less than the
$38.35 per user cost of the HP ProLiant BL460c solution.

About the Dell PowerEdge M620 blade server

The Dell PowerEdge M620 is a half-height two-socket blade server powered by
the Intel® Xeon® processor E5 family that can hold up to 768 GB of RAM in 24 DIMM
slots. The PowerEdge M620 comes standard with several management features,
including iDRAC7 Express with Lifecycle Controller for Blades, which allow
administrators to manage physical or virtual environments locally or remotely. Along
with other members of the M-series PowerEdge server line, the PowerEdge M620 fits
right in with the power-efficient Dell PowerEdge M1000e Blade Enclosure.

For more information about the Dell PowerEdge M620, visit

http://www.dell.com/us/enterprise/p/poweredge-m620/pd.

About the Dell EqualLogic PS6110XV 3.5

EqualLogic PS6110XV 3.5 storage arrays use 3.5-inch, 6Gbps SAS disks to enable
high backend performance and support up to two controller modules in active-passive
failover mode. Each controller module features a single 10GbE host-side port and
contains 4 GB of cache, which is mirrored across both controller modules for high
availability and protected by a battery-powered cache offload mechanism.

Equallogic peer storage arrays provide virtualized storage by carving host
volumes out of storage pools consisting of one to eight arrays. Automatic tiering and
load-balancing mechanisms ensure high performance and high availability by
distributing volume pages both within and across arrays. Below, we summarize the
primary features of the PS6110XV 3.5:
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e Reliability. Hot-swap, incremental expansion options, dual power and network
controllers, and port sharing for failover scenarios to help ensure uptime

e Connectivity. 10GbE SFP+ module or cost-effective 10GBASE-T copper

e Capacity. Support for up to 24 hot-swappable 3.5" 15K SAS drives, for up to a
maximum of 14.4 TB of storage per array

e Performance. 6G SAS backplane and 10GbE interconnect technology

In addition to enterprise-class storage hardware, Dell EqualLogic PS Series arrays
include the necessary software features to enable full control over EqualLogic storage.
This includes the Dell EqualLogic Group Manager for array configuration management,
SAN Headquarters (SAN HQ) monitoring and analysis tools, and Host Integration Tools
for VMware®, Microsoft, and Linux® platforms.

According to Dell, “Equallogic all-inclusive array software provides you with
advanced functions that enable virtualized storage and data protection. With EquallLogic
Array Software, you don’t need to choose between data protection, capacity,
performance and advanced management. EqualLogic Array Software features all the
tools at no additional cost required for developing a sound data protection strategy and
automatically virtualizes and optimizes resources within the SAN to deliver consistent
application performance.”

EqualLogic Group Manager is a management tool integrated with the
Equallogic PS Series Firmware that can provide detailed information on your storage
configuration, and allows for storage provisioning, replication scheduling, and array
management. The EqualLogic Group Manager is available as a command-line interface
(CLI) or graphical-user interface (GUI) that can be accessed from most Web browsers
with a connection to the Equallogic storage area network (SAN).

Dell EqualLogic Host Integration Tools for Microsoft (HIT/Microsoft) is a
software toolkit that ships free with all Dell EqualLogic iSCSI SANs. This kit facilitates the
deployment, ongoing management, and protection of Dell EqualLogic iSCSI SANs for
Microsoft Windows environments, including virtualization support. Auto-Snapshot
Manager Microsoft Edition (ASM/ME), included with the toolkit, creates, schedules, and
manages application-consistent snapshots, replicas, and clones that can augment a full
data backup and recovery process. ASM/ME 4.5 adds SharePoint 2007 and 2010 to the
existing Microsoft application support that includes Microsoft Exchange and Microsoft
SQL Server®. ASM/ME 4.5 also includes support for Hyper-V Virtual Machines in Server
2008 and Server 2012 — including CSV'’s, VHD and VHDX.

Dell EqualLogic SANHQ monitors one or more PS Series groups. The tool is a

client/server application that runs on a Microsoft Windows server and uses SNMP to
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query the groups. SANHQ collects data over time and stores it on the server for later
retrieval and analysis. SANHQ enables the storage administrator to do the following:

e Monitor one or more PS Series groups and store operational data for up to a year
e Obtain a centralized view of the health and status of multiple groups

e Monitor and analyze capacity usage for groups

e View IO rates, throughput, and latency for each volume, member, pool, or group

e View estimated maximum IO capabilities

e Generate alerts and email notifications based on the health status of the groups

e Generate reports, including Top 10 Volume, Configuration, Performance and Alerts

reports

About the Dell PowerEdge M1000e Blade Enclosure
The Dell PowerEdge M1000e blade chassis and its supported fabric

interconnects are designed for dense computing situations. Features of the PowerEdge

M1000e include the following:

e Management. Reduces administrative demand by providing a secure centralized
management interface for the chassis and blades within, using proven Web (SSL-
encrypted) and CLI (SSH/Telnet) technologies.

o Simplified configuration. The Chassis Management Controller allows administrators
to control up to nine enclosures and 144 server blades, including BIOS/firmware
change management and updates, thermal monitoring, and power threshold
configuration.

e Flexible I/0. Six interconnect sockets with the capability to support three fully
redundant fabrics, a passive midplane with more than 8Tbps in I/O bandwidth
capacity, and FlexlO support provide a number of connectivity options for your
servers.

o Reliability and efficiency. Six power supplies and nine fans, all hot- swappable,
allowing for no-downtime maintenance of key chassis components. All components
are tuned for maximum power efficiency to reduce data center power consumption.
For more information about the Dell PowerEdge M1000e Blade Enclosure, visit
http://www.dell.com/us/enterprise/p/poweredge-m1000e/pd.

About Microsoft Windows Server 2012

Windows Server 2012, the latest release of this server OS from Microsoft,
includes many new features and enhancements. According to Microsoft, Windows
Server 2012 focuses on four core areas:

e Beyond virtualization. Windows Server 2012 provides a robust and dynamic
virtualization platform through Hyper-V, and includes new features that provide

flexible options for delivering cloud services.
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o The power of many servers, the simplicity of one. Windows Server 2012 offers

improvements in its features that allow for better-than-ever high availability and

ease of management for multiple-server infrastructures.

e Every app, any cloud. Windows Server 2012 delivers a scalable and flexible Web and

application platform by providing a consistent and open set of tools and frameworks

that apply to applications on-premises, in the cloud, or in a hybrid environment.

e Modern work style, enabled. Microsoft Windows Server 2012 empowers users and

IT staff with remote access to data, applications, and simpler management tools

while strengthening security and compliance.

WHAT WE FOUND

In our testing, we looked at the requests per second the solutions handled and

latencies while running the SharePoint workload to determine that the solutions could

support our 3,000-user workload.

We determined that the solutions could support the 3,000-user workload if they

achieved at least 50 requests per second. A short response time or latency is also an

important measure of performance—it means that the users need to wait less time for

the server to complete a request. As Figure 2 shows, both solutions achieved 50

requests per second while maintaining the acceptable less than 1-second SharePoint

average response time. This shows that both solutions performed comparably.

SharePoint requests per second

SharePoint avg. response time (seconds)

Dell PowerEdge M620 solution

55.6

0.27

HP ProLiant BL460c Gen8 solution

55.5

0.27

Figure 2: Test results from the 3,000-user SharePoint workload for the Dell and HP solutions. For SharePoint average response
time, lower numbers are better. For SharePoint requests per second, higher numbers are better.

Figure 3 compares the total initial costs of the two solutions, along with the cost

per SharePoint user you could expect to pay for each solution. Appendix A details the

components of the solution.

Dell PowerEdge M620 solution

HP ProlLiant BL460c Gen8 solution

Total cost of tested system (blades,
switches, and storage)

$85,198.00"

$115,057.15

Cost per user (total cost/3,000 users)

$28.40

$38.35

Figure 3: Total initial costs and cost per user for the Dell and HP solutions. We show list prices, which do not include discounts,

tax, or shipping costs.

! The Dell Solution includes the Equallogic storage software bundle at no additional charge to the customer. This includes the
Equallogic Array Software, SAN Headquarters (SAN HQ) monitoring and analysis tools, and Host Integration Tools for VMware®,

Microsoft, and Linux® platforms.
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WHAT WE TESTED

Collaboration testing

We used test clients running Microsoft Visual Studio® 2010 to execute the test
workload, and found that both solutions could handle 3,000 users while delivering
acceptable performance. To simulate the traffic of SharePoint users, we used a custom
workload with a user profile that browsed or completed a typical user task on various
SharePoint Web pages and uploaded or accessed sample files. We determined that the
solutions could handle the 3,000 simulated users because the solutions achieved over
the minimum 50 requests per second while maintaining an average SharePoint response
time, or latency well below the acceptable threshold of 1 second.

Each solution had four VMs, two running on each blade. One server ran a
Microsoft Windows Server 2012 VM and Microsoft SQL Server 2012 to hold the
SharePoint databases, and a Windows Server 2008 R2 SP1 VM and SharePoint Server
2010 running as a SharePoint Web Server. The other server ran two Windows Server
2008 R2 SP1 VMs, one running an additional SharePoint Server 2010 Web server and the

other running all of the other SharePoint server roles including Central Administration.

To simulate the traffic of SharePoint Server 2010 users, we used the WSSDW
1.0.0.0 Beta test. This test creates sample data, populates the server with it, and
simulates SharePoint Server users completing everyday tasks, each of which generates a
request on the SharePoint Server VMs.

We used Visual Studio 2010 to execute the test workload, generating a realistic
heavy user workload where each of the simulated heavy users generated a request
every minute. This means that each solution needs to complete 3,000 requests per
minute, or 50 requests per second. To ensure that the workload placed enough stress
on the solution to achieve this performance of at least 50 requests per second, we set
up the test to run 75 Visual Studio virtual users with a 1-second think time in between
each of the various requests, allotting up to half a second, on average, for each task to
complete. Additionally, we generated SharePoint content database of approximately
1TB as a representative sample size for a higher user count. The test workload then
reports throughput in the number of completed requests per second. We determine
acceptable performance if a solution completes at least 50 requests per second with an
average SharePoint response time of under a second.

For more details about SharePoint Server, see http://office.microsoft.com/en-

us/sharepoint-server-help/.
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IN CONCLUSION

The server and storage solution you choose for your SharePoint workloads can
greatly affect the collaborative experience in the workplace. Not only should the servers
be powerful enough to deliver a solid experience for the large number of end-users that
need to collaborate on documents, the hardware solution should minimize the cost per
user to help keep data center costs low. In our tests, we found that we could virtualize
SharePoint on two Dell PowerEdge M620 servers and a Dell EqualLogic PS6110XV array
and support the same 3,000 users as on the HP ProLiant BL460c Gen8, but at a
significantly lower cost. The Dell PowerEdge M620 solution cost only $28.40 per user;
26.0 percent less than the $38.35 per user that the HP ProLiant BL460c Gen8 solution
would cost to purchase.

Choosing a server and storage solution that delivers the strong performance
your data center requires while providing a lower cost per user can have a positive
impact on your IT budget.
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APPENDIX A — SERVER AND STORAGE CONFIGURATION INFORMATION

Figure 4 provides detailed configuration information for the test systems, and Figure 5 provides detailed

information about the test storage.

Server

Dell PowerEdge M620

HP ProlLiant BL460c Gen8

Enclosure

Blade enclosure

‘ Dell PowerEdge M1000e

HP BladeSystem C7000

General dimension information

Height (inches) 17.25 17.40
Width (inches) 19.0 17.6
Depth (inches) 29.5 32.0
Power supplies
Total number 6 6
Wattage of each (W) 2,360 2,450
Cooling fans
Total number 9 10
Dimensions (h x w) of each 3.25" x 3.25" 3.50" x 3.00"
Voltage (V) 12 12
Amps (A) 7.0 16.5
General processor setup
Number of processor packages 2 2
Number of cores per processor 6 6
package
Number of hardware threads per core | 12 12
System power management policy Balanced Balanced
CPU
Vendor Intel Intel
Name Xeon E5-2640 Xeon E5-2640
Stepping 2S 2S
Socket type LGA2011 LGA2011
Core frequency (GHz) 2.50 2.50
L1 cache 32 KB + 32 KB (per core) 32 KB + 32 KB (per core)
L2 cache 256 KB (per core) 256 KB (per core)
L3 cache 15 MB (shared) 15 MB (shared)
Platform
Vendor and model number Dell PowerEdge M620 HP ProLiant BL460c Gen8
Motherboard model number 0GVN4C 654609-001
BIOS name and version Dell 1.2.6 6/26/2012 HP 131 07/15/2012
BIOS settings Default Default
Memory modules
Total RAM in system (GB) 64 64

Vendor and model number

Samsung M393B1K70BH1-CH9

Samsung M393B1K70BH1-CH9

Type

PC3-10600R

PC3-10600R
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Server Dell PowerEdge M620 HP ProLiant BL460c Gen8
Speed (MHz) 1,333 1,333

Speed in the system currently running

@ (MHz) 1,333 1,333

Tlmlng/latency (tCL-tRCD-iRP- 9-9-9-24 9-9-9-24

tRASmMIn)

Size (GB) 8 8

Number of RAM modules 8 8

Chip organization Double-sided Double-sided

Hard disks

Vendor and Model Number

Dell MBE2147RC

HP EHO146FARWD

Number of disks in the system 2 2

Size (GB) 146 146

Buffer size (MB) 16 16

RPM 15,000 15,000

Type SAS SAS

Operating system

Name Windows Server 2012 Datacenter Windows Server 2012 Datacenter

Build number 9200 9200

File system NFTS NFTS

Language English English

Network adapter 1

Type Mezzanine Mezzanine

Vendor and model number Intel X520 10 GbE Dual-port HP Flex10 10 Gb Dual-port
KX4-KR Adapter 530FLB Adapter

Network adapter 2

Type N/A Flex Module

Vendor and model number N/A HP FlexFabric 10 Dual-port 554M

Adapter

Storage controller 1

Vendor and model number

Dell PERC H310 Mini

HP Smart Array P220i

Cache size 0 MB 512 MB
Driver 5.1.118.64 4/15/2012 6.24.0.64 2/1/2012
Firmware 20.10.1-0084 08/13/2012 3.22 10/26/2012

Figure 4: System configuration information for the test servers.
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Storage array Dell PowerEdge M620 solution HP ProlLiant BL460c Gen8 solution
Array Dell EqualLogic PS6110XV 3.5 Leading competitor array
Number of storage controllers |2 2

Number of active storage ports |1 4

Number of drives 24 24

Disk vendor and model

number Seagate ST3600057SS Seagate ST3450857SS
Disk size (GB) 600 450

Disk buffer size (MB) 16 16

Disk RPM 15,000 15,000

Disk type SAS SAS

Figure 5: Configuration information for the test storage.

For our network switches, we used a Dell PowerConnect™ 5524p to connect the test clients with the blade

server solutions under test. Additionally, we used the following switches for each solution:

o Dell PowerEdge M620 solution

o Blade switches

2 x Dell Force10™ MXL 10/40 GbE
2 x Dell PowerConnect M8024-k

e HP ProlLiant BL460c Gen8 solution

o Blade switches

2 x HP VC Flex-10 Enet Module
2 x HP 1 Gb Ethernet Pass-thru

o Rack switch

Cisco Nexus 5010

Windows Server 2012 on Dell - Great performance and value for the
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APPENDIX B - HOW WE TESTED

Our test setup consisted of two blade servers, each hosting two VMs on Microsoft Hyper-V for Windows Server
2012 Datacenter. One blade server hosted a VM running SQL Server 2012. The other blade server hosted a VM for
running SharePoint 2010 applications. In addition, each blade hosted a second VM for running SharePoint 2010 front-
end Web services.

Each VM was given 8,192 MB of RAM and 8 virtual processors. The SQL Server 2012 VM used Windows Server
2012 Datacenter, and all three SharePoint 2010 VMs used Windows Server 2008 R2. Any OS VHDs were stored locally,
while two VHDs for SQL data and logs were stored externally. Incoming SharePoint requests from the client were load
balanced across the two webserver VMs using the Microsoft Windows Network Load Balancing feature.

We also configured additional servers for the Active Directory Domain Services role, and WSSDW test clients.
We configured the leading competitor array using recommended best practices and in as equivalent a configuration as
possible as the Dell storage array.

Configuring the Active Directory server

Installing Microsoft Windows Server 2012 Datacenter Edition
1. Insert the installation media into the CD/DVD drive and restart the server.

2. When the option appears, press F11 to enter the Boot Manager.

3. Select SATA Optical Drive and press Enter.

4. Press any key when prompted to boot from DVD.

5. When the installation screen appears, click My language is English.

6. Leave language, time/currency format and input method as default and click Next.

7. Click Install now.

8. When the Windows Setup window appears, click No thanks when prompted to go online to install updates.

9. Select Windows Server 2012 Datacenter (Server with a GUI), and click Next.

10. Check I accept the license terms, and click Next.

11. Click Custom: Install Windows only (advanced).

12. Press Alt+A to open advanced partition options. Delete any partitions until there is only Drive 0 Unallocated
Space.

13. Select Drive 0 Unallocated Space, and click Next, at which point Windows will begin installing, and will restart

automatically after completing.
14. When the Settings page appears, fill in the Password and Reenter Password fields with the same password.
15. Log in with the previously set up password.

Configuring Windows Update
1. Inthe left pane of the Server Manager window, click Local Server.

2. Inthe main frame, next to Windows Update, click Not configured.

3. Inthe Windows Update window, in the main pane, click Let me choose my settings.

4. Under Important updates, select Never check for updates (not recommended), and then click OK.

5. Inthe left pane, click Check for updates, and install all available updates.

6. Close the Windows Update window.
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Configuring Windows Firewall

1.

NoukswnN

In Server Manager, click Tools>Windows Firewall with Advanced Security.
In the Overview section, click Windows Firewall Properties.

In the Domain Profile tab, for Firewall state, click Off.

In the Private Profile tab, for Firewall state, click Off.

In the Public Profile tab, for Firewall state, click Off.

Then click OK.

Close the Windows Firewall Properties window.

Setting up Remote Desktop

1.
2.

In the Local Server tab of the Server Manager window, next to Remote Desktop, click Disabled.

In the System Properties window that appears, in the Remote Desktop section, select the Allow remote
connections to this computer radio button, and click OK when the warning message appears.

Uncheck Allow connections only from computers running Remote Desktop with Network Level Authentication
(recommended), and click OK.

Disabling IE Enhanced Security Configuration

1.
2.

In the Local Server tab of the Server Manager window, next to IE Enhanced Security Configuration, click On.
In the Internet Explorer Enhanced Security Configuration window, select the Off radio buttons for both
Administrators and Users, and click OK.

Installing the Active Directory Domain Services role

Before completing this step, you will need to apply an appropriate IP address for the server.

1. Launch Server Manager and select Add roles and features.

2. Click Next at the Add Roles and Features Wizard.

3. Select Role-based or feature-based installation, and click Next.

4. Select the AD server from the server pool, and click Next.

5. Select Active Directory Domain Services from the list of Roles, click the Add Features button to add features that
are required by Active Directory Domain Services, and click Next.

6. Accept the defaults selected by setup at the Select Features screen, and click Next.

7. Click Next at the AD DS screen.

8. Select Restart the destination server automatically if required at the confirmation screen, and click Install.

9. Click Promote this server to a domain controller.

10. Select Add a new forest, type in the Root domain name (fqdn), and click Next. For our testing, we used test.local

11. Type in and confirm the password, and click Next.

12. Click Next at the DNS Options screen.

13. Verify the NetBIOS name, and click Next.

14. Accept the default paths, and click Next.

15. Review the options, and click Next.

16. Verify the prerequisite check passes successfully, and click Install.
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Configuring the blade servers and storage
Installing Microsoft Windows Server 2012 Datacenter
1. Connect the installation media and restart the server.
When the option appears, press F11 to enter the Boot Manager.
Select SATA Optical Drive and press Enter.
Press any key when prompted to boot from DVD.
When the installation screen appears, click My language is English.
Leave language, time/currency format and input method as default and click Next.
Click Install now.
When the Windows Setup window appears, click No thanks when prompted to go online to install updates.
Select Windows Server 2012 Datacenter (Server with a GUI), and click Next.
. Check | accept the license terms, and click Next.

Lo N R WN
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. Click Custom: Install Windows only (advanced).
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. Press Alt+A to open advanced partition options. Delete any partitions until there is only Drive 0 Unallocated
Space.
13. Select Drive 0 Unallocated Space, and click Next, at which point Windows will begin installing, and will restart
automatically after completing.
14. When the Settings page appears, fill in the Password and Reenter Password fields with the same password.
15. Log in with the previously set up password.
Configuring Windows Update
1. Inthe left pane of the Server Manager window, click Local Server.
In the main frame, next to Windows Update, click Not configured.
In the Windows Update window, in the main pane, click Let me choose my settings.
Under Important updates, select Never check for updates (not recommended), and then click OK.
In the left pane, click Check for updates, and install all available updates.

vk wnwN

6. Close the Windows Update window.

Configuring Windows Firewall
1. In Server Manager, click Tools>Windows Firewall with Advanced Security.
In the Overview section, click Windows Firewall Properties.
In the Domain Profile tab, for Firewall state, click Off.
In the Private Profile tab, for Firewall state, click Off.
In the Public Profile tab, for Firewall state, click Off.
Then click OK.
7. Close the Windows Firewall Properties window.

o vk wnN

Enabling Remote Desktop
1. Inthe Local Server tab of the Server Manager window, next to Remote Desktop, click Disabled.

2. Inthe System Properties window that appears, in the Remote Desktop section, select the Allow remote
connections to this computer radio button, and click OK when the warning message appears.

3. Uncheck Allow connections only from computers running Remote Desktop with Network Level Authentication
(recommended), and click OK.
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Disabling IE Enhanced Security Configuration

1.
2.

In the Local Server tab of the Server Manager window, next to IE Enhanced Security Configuration, click On.
In the Internet Explorer Enhanced Security Configuration window, select the Off radio buttons for both
Administrators and Users, and click OK.

Adding the MPIO feature

1.
2.
3.

L N O Uk

In Server Manager, click Manage—>Add Roles and Features.

At the Before you begin screen, click Next.

At the Select installation type, leave the default selection of Role-based or feature-based installation, and click
Next.

At the Select destination server screen, leave the default selection, and click Next.

At the Select server roles screen, click Next.

When the Add Roles and Features Wizard window pops up, click Add Features.

Click Next.

At the Select features screen, check the box for Multipath 1/0 and click Next.

At the Confirm installation selections screen, click Install.

10. When the installation completes, click Close.

Installing Dell EqualLogic Host Integration Tools

1.

W oo N R WN

Insert the disk, and click Setup.exe.

At the Welcome screen, click Next.

At the License Agreement screen, review and accept the terms of the license agreement, and click Next.

At the Destination Folder screen, click Next.

At the Select Type screen, select Custom, and click Next.

At the Custom Setup screen, disable the Auto-Snapshot Manager/Microsoft Edition feature, and click Next.
At the Ready to Install the Program screen, click Install.

At the Installation Complete screen, click Finish.

In the pop-up window that follows to restart the system, click Yes.

Running the Remote Setup Wizard for the Dell EqualLogic PS6110XV

1.
2.

Lo N R W

Press the Windows key, and open Remote Setup Wizard.

At the Welcome screen, leave the radio button on Initialize a PS Series array, and click Next. The Remote Setup
Wizard will search for uninitialized PS Series arrays.

At the All PS Series arrays have been initialized screen, select the storage array, and click Next.

At the Initialize Array screen, enter the appropriate information, and click Next.

Under Group Information, leave the Create a new group radio button selected, and click Next.

At the Create a New Group screen, enter the appropriate information.

Select the desired RAID level. We selected RAID 10 for the RAID Policy.

Under Credentials for New Group, enter the passwords.

Under CHAP credentials for VDS/VSS access to group, enter a user name and password, and click Next.

10. On the Initialization Successful pop-up, click OK.
11. Click Finish.

Configuring MPIO settings

1.

Press the Windows key, and open Remote Setup Wizard.
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At the Welcome to the Remote Setup Wizard screen, select Configure MPIO settings for this computer, and click
Next.

Under Subnets included for MPIO, select the subnets you wish to exclude from MPIO.

Click Exclude.

Click Finish.

Configuring the Dell EqualLogic PS6110XV storage

1.
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Press the Windows key, click Internet Explorer, and enter the IP address of the Dell EqualLogic PS Series Group
Manager.

Log into Group Manager using the appropriate credentials.

Expand Members, right-click the unconfigured member and select Configure member.

At the Step 1 — General Settings screen, click Next.

At the Step 2 — RAID Configuration screen, select the radio button for RAID 10 and click Next.

Click Finish.

Expand Members, click the member name, and in the right pane, select the Network tab.

Right-click the management port, and select Enable interface.

Click Yes in the Enable network interface popup that appears.

. Click OK in the Warning popup that appears.

. Right-click, and select Modify IP settings.

. Enter the desired IP address for the management port, and click OK.
. Create the volume:

a. Inthe left pane, click Volumes, and, in the adjacent pane, click Create volume.
a. Namethevolume VirtualMachinel and click Next.

b. Type 1000 forthe Volume size, and click Next. For our testing purposes, we did not create a
snapshot reserve with the volume.

c. Onthe Step 3 —iSCSI Access screen, click the Allow simultaneous connections from initiators with
different IQN names checkbox, and perform the following, depending on the volume you are creating:

i. Check the Limit access to iSCSl initiator name box, and enter the appropriate iSCSl initiator
name. For our testing, thiswas ign.1991-05.com.microsoft:bladel.test.local
d. Click Finish.

Connecting to the volumes with Microsoft iSCSI Initiator

1.
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To launch iSCSI Initiator, select Tools from the Server Manager menu, and click iSCSI Initiator.

Select the Discovery Tab, and click Discover Portal.

Enter the IP Address for the Dell EqualLogic Storage Group, and click OK.

Select the Targets tab, and click Refresh.

Select the first Inactive Target listed, and click Connect.

Ensure that Add this connection to the list of Favorite Targets is selected, check the Enable multi-path check box,
and click OK.

Creating a volume in Windows Server 2012

1. To launch Disk Management, select Tools from the Server Manager menu, and click Computer Management.
2. Inthe left pane, click Disk Management.
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Right-click the Unknown disk, and select Online.

Right-click the Unknown disk, and select Initialize Disk.

Click OK on the Initialize Disk dialog.

Right-click the newly initialized disk, and select New Simple Volume.
Click through the wizard to accept all defaults.

Close Computer Management.

Adding the Hyper-V role

1.

14.

In Server Manager, click Manage—>Add Roles and Features.

At the Before you begin screen, click Next.

At the Select installation type, leave the default selection of Role-based or feature-based installation, and click
Next.

At the Select destination server screen, leave the default selection, and click Next.

At the Select server roles screen, check the box for Hyper-V, and click Next.

When the Add Roles and Features Wizard window pops up, click Add Features.

Click Next.

At the Select features screen, click Next.

At the Hyper-V screen, click Next.

. At the Create Virtual Switches screen, leave the NICs unselected, and click Next.

. At the Virtual Machine Migration screen, leave the checkbox unselected, and click Next.

. At the Default Stores screen, leave the default locations, and click Next.

. At the Confirm installation selections screen, check Restart the destination server automatically if required and

click Install.
When the installation completes, click Close.

Creating a virtual switch

i e

5.
6.

Complete the following steps on each host server:

Open Server Manager, and click Tools=>Hyper-V Manager.

In the right pane, click Virtual Switch Manager.

Leave External highlighted under type of virtual switch, and click Create Virtual Switch.

Enter a name, and select the appropriate network adapter. Check the Allow management operating system to
share this network adapter, and click Apply.

When the warning pops up, click Yes.

Click OK.

Creating a virtual machine

1.
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Open Server Manager, and click Hyper-V on the left hand side.

Right-click the local server, and click Hyper-V Manager.

Click New, and select Virtual Machine.

Enter a name for the VM, and click Next.

Enter 8192 for the Startup Memory. Click Next.

On the Configure Networking screen, select the appropriate virtual switch and click Next.

On the Connect Virtual Hard Disk screen, select the radio button for Create a virtual hard disk. Enter a name for
the VHD and a size of 50 GB. Click Finish.
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8. After the VM is created, right-click the VM and click Settings.
9. Click Processor and increase Number of virtual processors to 8.
10. Click OK.

Creating a virtual hard disk
For the SQL Server VMs, we added additional virtual hard drives for the database files hosted on the external

storage.

1. Open Server Manager, and click Hyper-V on the left-hand side.
Right-click the local server, and click Hyper-V Manager.
Click New, and select Hard Disk.
Click Next.
Select VHDX, and click Next.
Select Fixed size, and click Next.
Give the hard disk a name and location, and click Next.
Select Create a new blank virtual hard disk and enter a size.
Click Finish.

LNV WN

Creating the SQL VMs

We installed Windows Server 2012 Datacenter edition and applied all available updates and same basic

Windows settings as the host server.

Creating New Disks in Windows Server 2012 Datacenter Edition
1. Inthe Server Manager window, click Tools, then Computer Management.

2. Inthe left pane, click Disk Management.
3. Onthe unallocated disk, right-click the disk name and click Online. Right-click the disk name again and click
Initialize Disk. When the Initialize Disk window pops up, select MBR (Master Boot Record) and click OK.
After the disk initializes, right-click the shaded area and click New Simple Volume.
On the New Simple Volume Wizard that pops up, click Next.
Select a size (maximum, in our case) and click Next.
Assign a drive letter and click Next.
Select Format this volume with the following settings and leave the default settings. Click Next.
9. Click Finish.
Installing SQL Server 2012
1. Insert the installation DVD for SQL Server 2012
2. Click Run SETUP.EXE. If Autoplay does not begin the installation, navigate to the SQL Server 2012 DVD, and
double-click it.
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3. If the installer prompts you with a .NET installation prompt, click Yes to enable the .NET Framework Core role.

4. In the left pane, click Installation.

5. Click New SQL Server stand-alone installation or add features to an existing installation.

6. Atthe Setup Support Rules screen, wait for the rule check to complete. If there are no failures or relevant
warnings, click OK.

7. Enter your product key, and click Next.

8. Select the Specify a free edition radio button, and click Next.
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10.
11.
12.

13.
14,

15.

16.

17.

18.

19.

20.

21.

22.

23.
24,

Click the checkbox to accept the license terms, and click Next.

If no failures are displayed after the setup support files are installed, click Next.

At the Setup Role screen, choose SQL Server Feature Installation.

At the Feature Selection screen, select the features that your organization requires. We chose the following
features for our test: Database Engine Services, Full-Text and Semantic Extractions for Search, Client Tools
Connectivity, Client Tools Backwards Compatibility, Management Tools — Basic, and Management Tools —
Complete. Click Next.

At the Installation Rules screen, click Next after the check completes.

At the Instance configuration screen, enter the appropriate details for your configuration. For a default instance,
leave the defaults selected. For a named instance, enter a new instance name and adjust the file paths as
necessary. Click Next.

At the Disk Space Requirements screen, click Next.

At the Server Configuration screen, choose the service account, preferably an Active Directory domain account,
fill in a password if necessary, and click Next.

At the Database Engine Configuration screen, choose Mixed Mode and enter the system administrator
password. Click Add Current User.

Click the Data Directories tab, and enter the appropriate drive and folder to which you eventually deploy the
SharePoint databases.

Click Next.

At the Error reporting screen, click Next.

At the Installation Configuration Rules screen, check that there are no failures or relevant warnings, and click
Next.

At the Ready to Install screen, click Install.

After installation completes, click Close.

Close the installation window.

Creating the SharePoint VMs

We installed Windows Server 2008 R2 SP1 Enterprise edition and applied all available updates and same basic

Windows settings as the host server.

Installing Microsoft SharePoint Server 2010

1.
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11.

Insert the installation DVD.

Launch setup.exe, and click Install software prerequisites.

Review the list of software, and click Next.

Accept the EULA, and click Next.

When the prerequisites finish installing, click Finish.

On the main SharePoint installation menu, click Install SharePoint Server.
Enter your product license key, and click Continue.

Accept the EULA, and click Continue.

Choose the Complete server type, and click Install.

. When the installation finishes, check the box for Run the SharePoint Products Configuration Wizard now, and

click Close.
On the Welcome to SharePoint Products screen, click Next.
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12. On the pop-up warning about services that will need to be restarted during the configuration, click Yes.
13. Choose Create a new server farm, and click Next.
14. Enter the name of your existing database instance on the same application server.
15. Specify a username and password, and click Next.
16. Enter a passphrase into the Passphrase and Confirm Passphrase fields, and click Next.
17. Leave the default settings on the Configure SharePoint Central Administration Web Application screen, and click
Next.
18. Verify your settings, and click Next.
19. When the wizard has completed the configuration, click Finish.
20. Choose Run the farm configuration wizard on the Central Administration site.
21. Choose the services you wish to include in your server farm, and click Next.
22. Enter the specifications for the new site, and click OK.
23. Click Finish.
Recreating the default SharePoint site
1. Open SharePoint Central Administration.
Click Manage Web Applications.
Click SharePoint — 80, and click Delete.
Select both Yes radio buttons, and click OK.
Return to Manage Web Applications, and click New.
Enter a URL and port number (we used http://spsite:80), and give the domain Administrator account access.
7. Click Create.
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Configuring the SharePoint Web servers
1. Open SharePoint Central Administration.

2. Click Manage services on server.
3. For each Web server, disable all services, and enable the following services:
a. Microsoft SharePoint Foundation Incoming E-Mail
b. Microsoft SharePoint Foundation User Code Service
c. Microsoft SharePoint Foundation Web Application
d. Microsoft SharePoint Foundation Workflow Timer Service
4. For the application server, disable the four services above and enable every other service.

Setting up Network Load Balancing
1. On each Web server, install the Network Load Balancing feature through Server Manager.

2. Onone Web server, click Start = Administrative Tools 2 Network Load Balancing Manager.
3. Right-click Network Load Balancing Cluster, and click New Cluster.
4. Click Add.
5. Inthe Host field, type the hostname of the current Web server, and click Connect.
6. Click Next.
7. Inthe IPv4 address field, type a cluster IP address. This is the IP address that the Web servers share and should
be used to the SharePoint default site in DNS.
In the Subnet mask field, type an appropriate mask.
Click OK.
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10. Give the cluster an appropriate name on the domain, select the Multicast radio button, and click Next.
11. Click Finish.

12. Right-click the newly created cluster, and click Add Host To Cluster.

13. Enter the hostname of another Web server, and click Connect.

14. Click Next.

15. Click Next.

16. Repeat steps 12-15 for each additional Web server.

Preparing the SharePoint test client
We installed Windows Server 2008 R2 SP1 with all available updates.

Installing Microsoft Visual Studio 2010 Ultimate Edition
1. Download vs_ultimateweb.exe from www.microsoft.com/download/en/details.aspx?id=12752

Double-click vs_ultimateweb.exe to run the installer.
Uncheck the box beside Yes, send information about my computer, and click Next.
If you see a pop-up requiring a Windows Imaging component, click the Windows Imaging Component is

W

Required link.

5. Click Download on the appropriate Imaging component, and choose Run.

6. Acceptthe EULA, and click Next.

7. Close the pop-up window.

8. Click Next.

9. Accept the EULA, review the components to be installed, and click Next.

10. Choose the Full installation and location for the install, and click Install.

11. Click Finish.

12. Reboot the machine.

13. Click Start->All Programs—>Microsoft Visual Studio 2010-> Microsoft Visual Studio 2010.
14. When prompted, select General Development Settings and click Start Visual Studio.

Setting up and running WSSDW 1.0.0.0 Beta
1. Complete the following steps on the Domain Controller machine:

a. Click Start>Administrative Tools—=> Active Directory Users and Computers.
b. Right-click the domain name and select New—>Group.
c. Enter testdomaingroupl forthe group name.
d. Repeat steps a through c and create another group named testdomaingroup?2
2. Download the following from http://sptdatapop.codeplex.com/releases/view/1141
e To the SharePoint 2010 VM
o WSS Data Population Tool RunTime.zip

o WSS Data Population Tool.chm
o WSS Data Population Tool Sample.zip
e To the SharePoint 2010 test client
o WSS Performance Load Tests
3. Complete the following steps on the SharePoint 2010 VM:
a. Extract the contents of WSS Data Population Tool RunTime.zip and WSS Data Population Tool Sample.zip.
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b. Copy the contents of both extracted .zip folders (WSS Data Population Tool Run Time and WSS Data

Population Tool Sample) into the root of C:

4. Download SharePtServerDeployment.doc from http://www.microsoft.com/en-

/>

us/download/details.aspx?id=10009 and place it into the c:\wssdw folder.

a.

C.

Rename WSS Data Population Sample File.xmlto WSS _Data Population Sample File.xml so that

there are no spaces in the name. This allows the script to execute from the command prompt.

Right-click WSS_Data_Population_Sample_File.xml and click Edit to open the document in Notepad. Scroll

down to line 55 and remove “.txt” from the document name in the destfile parameter. Then, change any

applicable parameters to match the following:

<setproperty
<setproperty
<setproperty
<setproperty
<setproperty
<setproperty
<setproperty
<setproperty
<setproperty
<setproperty
<setproperty
<setproperty
<setproperty

<setproperty
<setproperty
<setproperty
<setproperty
<setproperty
<setproperty
<setproperty

NumberOfSiteCollections="100" />
SiteNameBase="testsiteA" />

NumberOfGroups="2" />

GroupNameBase="testgroup" />
TargetDomain="test.local" />
DomainGroupRoot="testdomaingroup" />
DomainUserName="administrator" />
DomainUserPassword="Passwordl" />
DesignerGroup="design" AdminGroup="full control" />
NumberOfDocumentLibraries="10" />
DocumentLibraryNameBasel="testdoclib A" />
NumberOfDocuments="10" />
SourceFileLocation="c:\wssdw\SharePtServerDeployment.doc"

DestFile="test.doc" />
NumberOfFileVersions="3" />
DocumentLibraryNameBase2="testdoclib B" />
NumberOfLists="10" />
ListNameBase="testlist" />
NumberOfListItems="20" />
webpartpath="webpartpagesfolder" />

Make 9 additional copies of WSS_Data_Population_Sample_File.xml and edit the SiteNameBase parameter

in each successive copy to testsiteB, testsiteC, etc. until testsitel.

d. Open 10 command prompts and in each one execute the script:

C:\>WSSDW.exe WSS Data Population Sample File A.xml http://spsite

In each prompt, replace A with the appropriate letter, so that each .xml is executed once.

5. Complete the following steps on the SharePoint 2010 test client:

a.

Extract the contents of WSS Performance Load Test to C: drive on the SharePoint test client.
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b. On the SharePoint test client, open the WSSTransactions folder, right-click=>Edit, and modify the following
files as follows:
® users.csv
Under username, password enter test.localladministrator,Passwordl and
remove the remaining entries.
e serverUrl.csv
Under serverUrl replace http://server with http://spsite.
e HierarchyManagerUsers.csv
Under username,password replace domain\username, password with
test.localladministrator, Passwordl
Open the WssTestProject.sln file in Visual Studio 2010 Ultimate.
When prompted, click Next.
Click Finish.
When prompted, leave the Retarget the project to .NET Framework 4. After the project opens, you can
retarget it to another Framework or Profile radio button selected, and click OK.
Click Close.
h. Inthe Solution Explorer pane, scroll to WSSDispForm, and double-click it.
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i. Expand the top menu under WSSDispForm in the left pane, expand Validation rules, and delete the FindText
entry that references mysite.aspx.
Click Save.

—

k. Repeat steps h through j for WSSHomePage and WSSSmallDocLibAllltems.

|.  Click Project=>Add Load Test.

m. At the Welcome to the Create New Load Test Wizard, click Next.

n. Enter Test for the load test scenario name, change the think time between test iterations to 1 second, and
click Next.

0. Atthe Load pattern settings for a load test scenario screen, select Constant load, enter 75 for the User

Count, and click Next.
p. Click Next at the Select a test mix model for the load test.
g. Atthe Add test to a load test scenario and edit the test mix, click Add and select the following tests from the
list below. Additionally, modify the distribution as follows:
e WSSDispForm 10%
e  WSSDocHTTPFetch 20%
e WSSHomePage 30%
e WSSSmallDoclLibAllltems 30%
e  WSSPutDocumentCoded 10%
r. Click OK.

s. Atthe Network types screen, select LAN, and click Next.
t. At the Browser screen, click Next.
u. At the Specify computers to monitor with counters sets during load test run screen, click Next.
v. Atthe Review and edit run settings for load test screen, enter 5 minutes for the Warm-up duration, enter 30
minutes for Run duration, 15 minutes for the Cool down duration, and click Finish.
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6. To ensure that the WSSDW workload evenly select a different SharePoint sites at random, create .csv lists of a
number of categories within each test and add the following parameters to each:
e WSSD WSSDispForm: Site name, list name, and list IDs.
e  WSSDocHTTPFetch: Site name, doc revision, document library name, and document name.
o \WSSHomePage: Site name
e WSSSmallDocLibAllltems: Site name, and document library name
e WSSPutDocumentCoded: Site name
7. Add the following lines of code to the WSSPutDocumentCoded test:

[DeploymentItem ("officeservertransactions\\siteNames.csv",
"officeservertransactions") ]

[DataSource ("Sites", "Microsoft.VisualStudio.TestTools.DataSource.CSV",
"|DataDirectory|\\officeservertransactions\\siteNames.csv",
Microsoft.VisualStudio.TestTools.WebTesting.DataBindingAccessMethod.Random,
Microsoft.VisualStudio.TestTools.WebTesting.DataBindingSelectColumns.SelectO
nlyBoundColumns, "siteNames#csv") ]

[DataBinding ("Sites", "siteNames#csv", "siteName",
"Sites.siteNames#csv.siteName") ]

At the "WebTestRequest request1" line, add:

+ this.Context["Sites.siteNames#csv.siteName"].ToString() +
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